UG-2020-13 ( Infineon
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iMOTION™ Modular Application Design Kit

About this document

Scope and purpose

This user guide provides an overview of the evaluation board EVAL-M1-301F including its main features, key
data, pin assignments and mechanical dimensions.

EVAL-M1-301F is an evaluation board as part of the IMOTION™ modular application design kit (MADK). This
board features and demonstrates Infineon’s advanced motion control engine (MCE 2.0) technology for
permanent magnet motor drives over the full speed range.

The evaluation board EVAL-M1-301F was developed to support customers during their first steps designing
applications using permanent magnet motors via sensorless sinusoidal control.

The IMC301A contains two cores - the motion control engine (MCE) and an additional microcontroller (MCU).
MCE support files and documentation will be available on the Infineon website. The MCU-related CMSIS pack
can be downloaded from the KEIL IDE, and this document does not cover it.

Intended audience

This User Guide is intended for all technical specialists who have a knowledge of motor control and high-power
electronics converters. The board is intended for use under laboratory conditions.

This board will be used during design-in, for evaluation and measurement of characteristics, and proof of data
sheet specifications.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.
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1 Important notice

Attention: The Evaluation Boards and Reference Boards as well as the information in this document are
solely intended to support designers of applications in evaluating the use of products from
Infineon Technologies for their intended applications.

Environmental conditions have been considered in the design of the Evaluation Boards and
Reference Boards provided by Infineon Technologies. The design of the Evaluation Boards
and Reference Boards has been tested by Infineon Technologies only as described in this
document. The design is not qualified in terms of safety requirements, manufacturing and
operation over the entire operating temperature range or lifetime.

The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject
to functional testing only under typical load conditions. Evaluation Boards and Reference
Boards are not subject to the same procedures as regular products regarding returned
material analysis (RMA), process change notification (PCN) and product discontinuation (PD).

Evaluation Boards and Reference Boards are not commercialized products, and are solely
intended for evaluation and testing purposes. In particular, they shall not be used for
reliability testing or production. The Evaluation Boards and Reference Boards may therefore
not comply with CE or similar standards (including but not limited to the EMC Directive
2004/EC/108 and the EMC Act) and may not fulfill other requirements of the country in which
they are operated by the customer. The customer shall ensure that all Evaluation Boards and
Reference Boards will be handled in a way which is compliant with the relevant requirements
and standards of the country in which they are operated.

The Evaluation Boards and Reference Boards as well as the information provided in this
document are addressed only to qualified and skilled technical staff, for laboratory usage,
and shall be used and managed according to the terms and conditions set forth in this
document and in other related documentation supplied with the respective Evaluation Board
or Reference Board.

It is the responsibility of the customer’s technical departments to evaluate the suitability of
the Evaluation Boards and Reference Boards for the intended application, and to evaluate
the completeness and correctness of the information provided in this document with respect
to such application.

The customer accepts that the Evaluation Boards and Reference Boards are not intended to
be used in life-endangering applications such as medical, nuclear, military, life-critical or
other applications, where failure of the Evaluation Boards and Reference Boards, or any
results from the use thereof, can reasonably be expected to result in personal injury.

The Evaluation Boards and Reference Boards and any information in this document is
provided "as is" and Infineon Technologies disclaims any warranties, express or implied,
including but not limited to warranties of non-infringement of third party rights and implied
warranties of fitness for any purpose, or for merchantability.

Infineon Technologies shall not be responsible for any damages resulting from the use of the
Evaluation Boards and Reference Boards and/or from any information provided in this
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document. The customer is obliged to defend, indemnify and hold Infineon Technologies

harmless from and against any claims or damages arising out of or resulting from any use
thereof.

Infineon Technologies reserves the right to modify this document and/or any information
provided herein at any time without further notice.
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2 Safety precautions

Please note the following warnings regarding the hazards associated with development systems.

Table1 Safety precautions

Warning: The DC link potential of this board is up to 1000 Voc. When measuring
voltage waveforms by oscilloscope, high voltage differential probes must be used.
Failure to do so may result in personal injury or death.

Warning: The evaluation or reference board contains DC bus capacitors which take
time to discharge after removal of the main supply. Before working on the drive
system, wait five minutes for capacitors to discharge to safe voltage levels. Failure to
do so may result in personal injury or death. Darkened display LEDs are not an
indication that capacitors have discharged to safe voltage levels.

Warning: The evaluation or reference board is connected to the grid input during
testing. Hence, high-voltage differential probes must be used when measuring voltage
waveforms by oscilloscope. Failure to do so may result in personal injury or death.
Darkened display LEDs are not an indication that capacitors have discharged to safe
voltage levels.

Warning: Remove or disconnect power from the drive before you disconnect or
reconnect wires, or perform maintenance work. Wait five minutes after removing
power to discharge the bus capacitors. Do not attempt to service the drive until the bus
capacitors have discharged to zero. Failure to do so may result in personal injury or
death.

Caution: The heat sink and device surfaces of the evaluation or reference board may
become hot during testing. Hence, necessary precautions are required while handling
the board. Failure to comply may cause injury.

Caution: Only personnel familiar with the drive, power electronics and associated
machinery should plan, install, commission and subsequently service the system.
Failure to comply may result in personal injury and/or equipment damage.

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when
installing, testing, servicing or repairing the assembly. Component damage may result
if ESD control procedures are not followed. If you are not familiar with electrostatic
control procedures, refer to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage
or reduction in product lifetime. Wiring or application errors such as undersizing the
motor, supplying an incorrect or inadequate AC supply, or excessive ambient
temperatures may result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that
need to be removed prior to installation. Failure to remove all packing materials that
are unnecessary for system installation may result in overheating or abnormal
operating conditions.

>R B B BB
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3 Introduction

The EVAL-M1-301F evaluation board is a part of the iIMOTION™ modular application design kit for drives
(IMOTION™ MADK). In order to run a motor, the mating power board is required to interface this evaluation
board.

The MADK platform is intended for use with various power stages with different control boards. These boards
can easily be interfaced through the 20-pin iMOTION™ MADK M1, or the 30-pin iMOTION™ MADK M3 interface
connector. This board is equipped with a 20-pin M1 connector and is intended for running a single motor.

This evaluation board is designed to give comprehensible solutions of sensorless control of permanent magnet
motors over the full speed range. It provides Hall-sensor based or sensorless controls applying 3-phase and
type 3 of 2-phase modulation. PC interface is via a micro-USB connector and the on-board debugger is
galvanically isolated. The PC interface provides a UART connection to the MCE as well as a serial wire debug
(SWD) channel to the MCU.

The EVAL-M1-301F evaluation board is available from Infineon. The features of this board are described in the
main features chapter of this document, whereas the remaining paragraphs provide information to enable the
customers to copy, modify and qualify the design for production according to their own specific requirements.

Environmental conditions were considered in the design of the EVAL-M1-301F, but the board is not qualified in
terms of safety requirements or manufacturing and operation over the entire operating temperature range or
lifetime. The boards provided by Infineon are subject to functional testing only.

Evaluation boards are not subject to the same procedures as regular products regarding returned material
analysis (RMA), process change notification (PCN) and product discontinuation (PD). Evaluation boards are
intended to be used under laboratory conditions by technical specialists only.

Figure 1 shows the evaluation board EVAL-M1-301F. This document explains the features and details of this board
as well as the control IC, IMC301A-F064.

Figurel Evaluation board EVAL-M1-301F
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4 EVAL-M1-301F main features

EVAL-M1-301F is an evaluation control board for motor control applications. The kit demonstrates Infineon’s
motion control IC technology.

The evaluation board characteristics:
e Control board for any permanent magnet motor with field oriented control
e Compatible with all M1 boards
e Current sensing via single or leg shunt
e Sensorless or Hall-sensor based operation (connector for analog or digital hall sensors)
e Galvanicisolation between motor and pcinterface
o On-board debugger is powered by USB interface
o Motor controller is powered from power board
e Micro-USB connector to on-board debugger
o Access to MCE via virtual COM port
o Access to MCU via SWD debug channel (Segger® J-Link light)
e Optional pin headers available
e RoOHS complaint
e PCBsizeis 65x45 mm

Main features of the IMC301A-F064 motion control IC include:
o Dual core device with MCE and MCU connected via high speed serial link
e MCE and MCU run in parallel and independently from each other
e MCE controls the motor
e MCU is used for system tasks, communication, monitoring, data logging, any anything else
e High-speed serial link (JCOM) between MCE and MCU for commanding the MCE
e MCE (Motion Control Engine) as ready-to-use solution for variable speed drives
o Field-oriented control (FOC) for permanent magnet synchronous motor (PMSM)
Space vector PWM with sinusoidal commutation and integrated protection features
Capable of 3-phase and type 3 of 2-phase modulation
Multiple motor parameter support

O O O O

Flexible host interface options for speed commands: UART, 12C, SPI, PWM or analog signal
o UL/ CSA 60730 certified (Class B)

e Additional microcontroller (MCU) based on Arm® Cortex® MO core
o 96/48 MHz clock, 128 /16 KByte Flash/SRAM

RTC/ systick/ watchdog timer, fast interrupt controller

o

o Various serial communication interfaces (UART, 12C, SPI)

o Peripheral set targeting system control and communication
e 3.3V (default) or 5V VDD power supply
e Scalable package options
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4.1 Functional description

Figure 2 shows a typical block diagram of a motor control application using the IMC301A-F064. The IMC301A-F064
provides a built-in, closed loop and sensorless control algorithm using the unique flexible motion control engine
(MCE) for permanent magnet motors. The MCE™ consists of a collection of control elements, motion peripherals,
a dedicated motion control sequencer and internal memory to map internal signal nodes. IMC301A-F064 also
employs a unique single shunt current reconstruction circuit in addition to a leg shunt current sensing circuit to
eliminate additional analog/digital circuitry.

The integrated MCU is based on an Arm® Cortex® MO0 core. It is internally connected to the MCE via a fast serial
port. The debug interface (SWD) is routed to the on-board debug interface via a galvanic isolation.

galvanicisolation M1 20 pin connector
board specific pin headers nc. < 15V
P VDD « 3.3V
| iMOTIONLink  GPIO UART |
i i 51 pwm
""""""""""""" » uN/wW
LED Status LED PGout < GK
micro USB < vDC
> VTH
SEGGER UARTO < 1U/1SS
J-Link ] Motion Control S < %
. Engine By w
XMC4200 (MCE 2.0)
SWD
:‘:‘,>
i A A A A
: | |
| |
v
33v AHALL12  hallconnector
DHALL 1/2/3
Figure2  Block diagram of the EVAL-M1-301F
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4.2 EVAL-M1-301F board specifications

Table 2 depicts the key specifications of the evaluation board EVAL-M1-301F.

Table 2 EVAL-M1-301F board specifications

Parameters Values Conditions [ comments

Host interface (not isolated)

UART(TXD, RXD) 0-VDD UARTO,UARTO_A, UART1_A
AIN 0-VDD Analog input
DIN 0-VDD Digital input
DOUT 0-VvDD Digital output
Input
VDD ‘3.3V(default),5v Controller supply voltage
DC bus
DC bus scaling 8.20 counts/V 13.3 kQ resistor on control board,
DC bus sensing range 499.54 \/ max and 2 MQ resistor on power board
Current feedback
Motor internal current feedback 1,3,6,12 Configured by MCEWizard
amplifier gain
Motor current sensing device 0-VDD/Gain Single shunt resistor
Leg shunt resistor
Motor current op-amp Non-Inverting Default setting
configuration
Motor current external 0.833
amplification gain
Resolution 12-bit PCB design may reduce the
resolution
Protection

NTC temperature shutdown value | 0-VDD (configured by
MCEWizard)

PCB characteristics

Material FR4, 1.6 mm thickness
Copper thickness = 1 0z (35 um)

Dimension 65 mm x45 mm
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4.3 Connectors and pin assignment

The EVAL-M1-301F consists of several functional groups which enable an out-of-the-box, fully functional motor
control system combined with additional interfaces and test points for more advanced use cases. Figure 3
shows the functional groups of the EVAL-M1-301F evaluation board.

Key information about the connections of the EVAL-M1-301F evaluation board is described below. Only the USB
interface and the M3 connector to the power board are mandatory, all other interfaces are optional.

. On-board debugger
. USB interface
connector (X101)
MCU core UARTO
and SWD connecter
(J3)

MCU core UART1
connecter (J9)

. Signal pin (J8)

. Signal pin (J6)
IMC301A-F064
iMOTION™ motor
control IC

. Signal pin (J7)

. Signal pin (J5)

. iIMOTION™ Link
connector(J4)

. Hall sensor input
connecter (J2)
.iMOTION™ MADK-
M1 20 pins
interface connector

i 6
Lﬁ%—t:ﬁonu:[l@!i

GEUBEEE

AlU ,' ;
= -
s (E '\'
hg =
; = P
JilE ) '_)
= N ;
. =e
nﬂneon ‘

;

g
2

AMOTION Link

Figure3  Functional groups of the EVAL-M1-301F evaluation board’s top side

Table 3 provides the pin assignments of the iIMOTION™ MADK-M1 20-pin interface connector J1. This connector
is the interface to the power board.

Table 3 J1- iMOTION™ MADK-M1 20-pin interface connector for control board
Pin No. Pin Details

1 PWMUH 3.3V compatible logic output for high side gate driver-Phase U
2 GND Ground
3 PWMUL 3.3V compatible logic output for low side gate driver-Phase U
4 GND Ground
5 PWMVH 3.3V compatible logic output for high side gate driver-Phase V
6 +3.3V On board 3.3 Vsupply
7 PWMVL 3.3V compatible logic output for low side gate driver-Phase V
8 +3.3V On board 3.3 Vsupply
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Pin No. Pin Details
9 PWMWH 3.3V compatible logic output for high side gate driver-Phase W
10 U+ Shunt voltage phase U
11 PWMWL 3.3V compatible logic output for low side gate driver-Phase W
12 IU- Ground
13 GK Gate kill signal - active low when over current is detected
14 DCBSENSE DC bus positive voltage, scaled in 0-3.3 V range by a voltage divider
15 VTH Thermistor input
16 IV+ Shunt voltage phase V
17 IV- Ground
18 IW+ Shunt voltage phase W
19 IW- Ground
20 VCC Defined for 15V power supply (not used in this board)

The EVAL-M1-301F supports the use of both digital as well as analog Hall sensors. Table 4 includes the details of
the Hall sensor interface connector.

Table 4 J2- Hall sensor Input
Pin Name Pin name connectors
1 GND Ground
2 DHAL1/AHAL1+ | Digital Hall sensor Inputl or analog Hall sensor Inputl+
3 DHAL2/AHAL1- | Digital Hall sensor Input2 or analog Hall sensor Input1-
4 DHAL3/AHAL2+ | Digital Hall sensor Input3 or analog Hall sensor Input2+
5 AHAL2- Analog Hall sensor Input2-
6 +3.3V +3.3V power supply

The IMC300 series of dual core controllers is the most flexible solution in terms of application support. A large
number of pins is made available on pin headers supporting multiple customer-use cases.

Table 5, Table 6, Table 7, Table 8, Table 9, and Table 10 include the details of the respective signal pins for the
application microcontroller (MCU). Functionality of the pins is flexible and can be assigned via the respective
program running on the MCU. For details please refer to the IMC300 hardware reference manual.

Table 5 J3- MCU UARTO and SWD

Pin Name Pin name connectors
1 SWDCLK User serial debug clock
2 SWDIO User serial debug /O
3 +3.3V +3.3V power supply
4 GND Ground
5 GND Ground
6 +3.3V +3.3V power supply
User Guide 110f39 Revision 1.1
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Pin Name Pin name connectors
7 P2.0 (RXDO_A) MCU serial port 0, RXD
8 P2.1 (TXDO_A) MCU serial port 0, TXD
Table 6 J4- iMOTION Link
Pin Name Pin name connector
1 SWDCLK User serial debug clock for MCU
2 SWDIO User serial debug 1/0 for MCU
3 +3.3V +3.3 V power supply
4 GND Ground
5 GND Ground
6 +3.3V +3.3V power supply
7 RXDO Reception of UARTO for MCE
8 TXDO Transmission of UARTO for MCE
Table 7 J5- MCU 10 connection
Pin Name Pin name connector
1 P2.1 (TXDO_A) Programmable 1/O, or MCU serial port 0, TXD
2 P2.2 Programmable I/O
3 P2.0 (RXDO_A) Programmable 1/O, or MCU serial port 0, RXD
4 P2.6 Programmable I/O
5 P4.7 Programmable I/O
6 P2.8 Programmable I/O
7 P4.6 Programmable I/O
8 P2.10 Programmable I/O
9 GND Ground
10 P2.11 Programmable I/0
Table 8 J6- MCU I/0 connection
Pin Name Pin name connector
1 P1.1 Programmable I/O
2 P1.0 Programmable I/O
3 +3.3V +3.3V power supply
4 GND Ground
5 P0.13 Programmable I/O
6 P0.8 Programmable I/O
7 P0.12 Programmable I/O
8 P0.9 Programmable I/O
9 P0.11 Programmable I/O
10 P0.10 Programmable I/O
User Guide 12 of 39 Revision 1.1
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Table 9 J7- MCU 1/0 connection
Pin Name Pin name connector
1 P4.1 Programmable I/O
2 P4.2 Programmable I/O
3 P4.0 Programmable I/O
4 P4.3 Programmable I/O
Table 10 J9- MCU UART1
Pin Name Pin Name Connector
5 GND Ground
6 +3.3V VDD
7 P4.4 (RXD1_A) MCU serial port 1, RXD
8 P4.5 (TXD1_A) MCU serial port 1, TXD

The motion control engine (MCE) in the IMC300 can read and drive pins directly and it also supports scripting.
Table 11 lists the MCE I/O pins that are made available. For functionality please refer to the Motion Control
Engine Software Reference Manual.

Table 11 J8- MCE GPIO pins
Pin Name Pin name connector
1 GPIO12 User configurable 1/0, digital
2 GPIO13 User configurable 1/0, digital
3 GPIO15 User configurable 1/0, digital
4 GPIO14 User configurable 1/0, digital
User Guide 13 0f 39 Revision 1.1
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5 Getting started with EVAL-M1-301F

In order to run the motor system, the following components are required:

e iMOTION™ MADK control board (EVAL-M1-301F)
e Matching MADK power board with M1 connector
e USB cable with micro-USB connector

Asingle USB interface is used to power the on-board debugger and interface to both the MCE as well as the
MCU. This setup is shown below in Figure 4.

MCEDesigner pc EVAL-M1-301F | M1 Power Board |

Virtual COM
port

o SEGGER UARTO

- 1 SEGGER 5V JLink —
e y J-Link |: XMC4200

= |

= H SWD
oy =
debugdll <::\:| |

——
Hall sensor connector

Power Supply

IPM or discrete

galvanic isolation

iMOTION™ IMC300

Motion Control
Engine
(MCE 2.0)

I_ll

Figure4 Board setup and interfaces to the MCE and the MCU

On the PC a virtual COM port is used to connect to the MCE, e.g. using the MCEDesigner. Chapter 5.1 describes
the setup and usage of the MCE and the respective tools.

Connection to the SWD debug interface of the MCU is provided via the SEGGER debug DLL. This DLL is part of
the installation of MCEDesigner but can also be installed and updated separately. The preferred C development
environment like Keil pVision is used to download and debug code on the MCU. (see Chapter 5.2)

The iIMOTION™ software tools, MCEDesigner and MCEWizard, are also required to initially set up the system, as
well as to control and fine-tune the system performance to match users’ exact needs. This chapter provides
more details on setting up the system and getting started with the IMOTION™ MADK development platform.

The MCE and MCU in the IMC301A work independently from each other. Code for the MCU can be downloaded
and debugged while the MCE is running the motor.
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5.1 Setting up the Motion Control Engine (MCE)

After downloading and installing the iIMOTION™ PC tools (MCEWizard and MCEDesigner), the following steps
need to be executed in order to run the motor. Refer to Chapters 5.2.1 and 5.2.2 as well as MCEWizard and
MCEDesigner documentation for more information.

1. Getthe latest IMC301A-F064 MCE software package available on www.infineon.com/imotion-software
website.

2. Connect PC-USB connector on the on-board-debugger to the PC via USB cable.

3. Connect EVAL-M1-301F M1 20-pin interface connector (J1) to power board (for example EVAL-M1-05-065D,
see Figure 5).

4. Use MCEWizard to enter the target motor’s system and operating parameters, as well as the hardware
parameters of the evaluation board, which will then be used to calculate controller’s digital parameter set
representing complete motor drive system. First click “Calculate” button on the “Verify & Save Page” and
then save the drive parameter set into your project directory by clicking “Export to Designer file (.txt)”.
Saved Drive System Parameter File will be later used by the MCEDesigner; refer to Chapter 5.2.1 or
MCEWizard user guide for more details.

5. Connect motor phase outputs to the motor.
6. Connect AC power to power input connector and power on system.

7. Start MCEDesigner tool and open MCEDesigner default configuration file (.irc) for IMC301A-F064 controller
(IMC301A_Vxxx.irc) by clicking “File” > “Open”. IMC301A_Vxxx.irc file is included in “IMC301A-F064 MCE
Software Package” downloaded in step 1.

8. MCEDesigner should automatically connect to the EVAL-M1-301F control board using default COM port
(indicated by green circle next to “COMx Up” status in the bottom frame of the MCEDesigner GUI). If it
cannot establish the connection, change COM port by doing the following steps: (“System” window active) >
Preferences > Connection > Connect using (Choose one of the other available COM ports from the drop-
down menu).

9. Incase the IMC301A-F064 IC on the EVAL-M1-301F is empty (not programmed), which will be indicated by
the pop-up window message after connecting to the MCEDesigner, then use following steps to program the
firmware and system parameters into the internal SRAM of iMOTION™ IC: Click “Tools” > “Programmer” and
select “Program Firmware and Parameters.” Browse and select the IMC301A-F064_A_Vxxx.ldf file which was
included in the “IMC301A-F064 MCE Software Package” downloaded in step 1. Then browse and select the
System Drive Parameters .txt file created in step 4. See chapter MCEDesigner setup overview 5.2.2 for more
details.

10. In case the IMC301A-F064 IC firmware has already been loaded, use the following steps to program the
system parameters into the internal SRAM of iMOTION™ IC: Click “Tools” > “Programmer” and select
“Program Parameters.” Browse and select the System Drive Parameters .txt file created in step 4. See
chapter MCEDesigner setup overview 5.2.2 for more details.

11. Start the motor by clicking the green traffic light button in the control bar.
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AC Power
Input

PC-USB .
Connector ]..

infineon 51

Eval-M-05-65D |
2016-07-18

Motor Phase
Outputs

Figure5 System connection example using EVAL-M1-301F and EVAL-M1-05-65D
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5.2 iMOTION™ development tools and software

The iIMOTION™ Development Tool installers for MCEDesigner and MCEWizard are available for download via
Infineon iIMOTION™ website (http://www.infineon.com/imotion-software). All supported tools and software
variants are listed there. Please visit this page periodically to check for tool/software updates.

The isolated on-board debugger provides the USB to UART bridge between the PC and the target iIMOTION™
device with 1kV DC galvanic isolation between the motor drive system (hot side) and the PC/debugger (cold
side). The on-board debugger uses the SEGGER J-Link driver for UART communication with IMC301A-F064. The
J-Link driver will be installed during the MCEDesigner installation. In case the driver is not installed properly,
please go to SEGGER J-Link website to download and install the latest J-Link “Software and Documentation
pack for Windows.”

5.2.1 MCEWizard setup overview

After installing the MCEWizard, please read the MCEWizard user guide first. Figure 6 shows the welcome page of
MCEWizard.

g MCEWizard 2.3.0.0 - Infineon Technologies = X

File JumptoPage Help

Welcome Page -

iMOTION™ 2.0 System Configuration Wizard

Welcome to MCEWizard! @

This tool is aimed to provide an easy
and intuitive way for configuring a
motor control system based on the
iMOTION motor control ICs.

The starting point of the system
configuration can be based on the
iMOTION MADK boards, which then
can be used with or without hardware
changes for setting up and running the
motor control system. Every
combination of the controller and =
power MADK board has its
corresponding System Configuration
File. Similarly, MADK Starter Kits have
their own System Configuration File.
Alternatively, the user can define his

own inverter hardware system by Get MADK Hardware Info Get iIMOTION™ Info
Lanswerina more auestions durina the |

Open System Configuration File
Save System Configuration File I

Previous Next

Figure6  Welcome page of MCEWizard

For new users, it is suggested to use this evaluation board with a released MADK power board, as they will
always have a tested parameter file available on the MADK website. The default power board in this user guide
is EVAL-M1-05-65D as shown in Figure 7.

iMOTION™ MADK system enables users to easily test different combinations of control and power boards with
their motors. User should be familiar with the system-level parameters related to the motor used. There are a
very limited number of parameters that are specific to the control board or power board hardware. Table 12
provides the MCEWizard setup overview for hardware-related parameters. Similar tables will be available in
each power board’s user guide. A combination of this table and the corresponding table of the power board
provides enough information to set up the MADK-based motor drive system in the shortest time.
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Table 12 MCEWizard setup overview table

Parameter

Value

Comment

Power board selecting

MADK power board name

If no, select similar
power board to modify

Motor 1 shunt configuration

Refer to the power board App Note

Controller supply voltage

Refer to the power board App Note

VDD is 3.3V by default

Max DC bus voltage

Refer to the power board App Note

DC bus sensing high resistor

Refer to the power board App Note

DC bus sensing low resistor

13.3kQ

NTC temperature shutdown
value

Calculated as in Section 6.2.2

Refer to the power
board App Note

GateSense low-side devices

Refer to the power board App Note

High is true by default

GateSense high-side devices

Refer to the power board App Note

High is true by default

Motor 1 current input

Calculated as in Section 6.1.2
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To start the MCEWizard system setup procedure, click the “Next” button in the right bottom corner as shown in
Figure 7.

n MCEWizard 2.3.0.0 - C:\Users\gliang1\Documents\EVAL-M1-301F-05-65D.mc2 = X

File JumptoPage Help

|Welcome Page v

iMOTION™ 2.0 System Configuration Wizard

Using System Configuration File:
EVAL-M1-301F-05-65D.mc2

This motor control system is an
evaluation kit for complete inverter-
controlled motor drive applications
based on EVAL-M1-301F iMOTION
MADK controler board (based on
IMC301A-F064 iMOTION controller)
and EVAL-M1-05-65D MADK inverter
board (based on IRSM505-065DA2
CIPOS Micro IPM).

Following two options are available. ~ —
If no hardware change is done on this
board and there is no plan to change
default control settings:

Select > Default Hardware and Control

Settings. Get MADK Hardware Info | | Get IMOTION™ Info |

Figure7  Opening the default configuration file of this board

After all the MCEWizard questions have been answered, the “Verify & Save Page” will be shown as in Figure 8.

u MCEWizard 2.3.0.0 - C\Users\gliangT\Documents\EVAL-M1-301F-05-650.mc2 — x

File JumptoPage Help

|Verify & Save Page -

Verify Parameters

Calculate Parameters Display Parameters Results |Exporl to MCEDesigner File (le)|

Double-Click an item to JUMP to its associated question

Figure8 Verify and Save page for MCEWizard
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Click “Calculate Parameters” button and “Export to Designer File (.txt)” button to save the parameter file that
will be used by the MCEDesigner in the next steps.

5.2.2 MCEDesigner setup overview

After installing the MCEDesigner installer, there is a shortcut for MCEDesigner on the Windows desktop. Double-
click on the shortcut to open MCEDesigner and then open “IMC301A_xx.irc” file (which was included in the
“IMC301A-F064 MCE Software Package” installed earlier, as instructed in Chapter 0) shown in Figure 9.

[ System - IMC3014 V1.03.0%.irc - MCEDesigner Ver 2.3.0.0 - Infineon Technologies - ] X
File View Preferences Tools Window Help
EECE] L]
W System - IMC3014 V1.03.01.irc e = || ® o [=] =
(W) C\Users\gliang 1\Documents\BO/ @\ C:\Users\gliang 1\Documents\BO/
= Monitor Definitions . 5 User Application Function Defi
B FluxrAngle & MotorSpeed B //=========z===2z2=:
E MotorSpeed &tTargetSpeec Start Mator
B lu & Iv_Fast Stop Motor
B lu & v Slow - B Drive Status
B e FicM Emergency Stop
B P Q & Flx M Configure Motor
B lu & MotorSpeed Reference Speed
Buaty =)
B Status & Spd /Trq
B status & lu stic
B FluxAngle & SpdErr B Read DC Voltage Count
Bidalg B Current Loop Tune
A Fo A & Fb B - B Speed Loop Tune
Bvdavg E Change Target Speed
B ldref & 1d B //========= Current Fe

- B Single Shunt Current Feedt
urrent Feedbac

unction Library Definition

ra
o B8 Register Structure Definitions

< > < >

For Help, press F1 IMC301A COM18 Down Trig Idle & Motor1 Inactive ® System Inactive

Figure9  MCEDesigner’s main display for EVAL-M1-301F

MCEDesigner programmer function can be used to program IMC301A-F064 firmware and/or system parameters.
To call up this function, click on “Tools” menu and then select “Programmer” in the pull-down list. The pop-up
window “Program IMC controller” will show up as in Figure 10.

To program both firmware and drive system parameters into IMC301A-F064 (which can happen when
programming the brand new devices with default factory settings for the first time, or when the new version of
iMOTION™ firmware is being downloaded), first click on the “Program Firmware and Parameter” radio button in
the “Program IMC controller” pop-up window. After that, select the “Drive System Parameter” file created using
MCEWizard by clicking on the “Browse...” button at the end of the “Program Parameter File” row, and then also
select the IMC301A-F064_A_Vxxx.ldf file (which was included in the “IMC301A-F064 MCE Software Package”) by
clicking on the “Browse...” button at the end of “Program Firmware File” row. Finally, click on the “Start”
button to program the parameter file into the IMC301A-F064 IC.
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B
File View Preferences Tools Window Help
EEEIE] (]
e [ |[@ | = Y o |l | =
T Ci\Users\gliang\Documents\BOZ W% C\UsersigliangT\Decuments\BOA
=] Manitor Definitions =1-E& User Application Function Defi
G- B FluxrAngle & MotorSpeed s [
- B MotorSpeed &TargetSpeec Start Mator
- B u 8 hv_Fast Stop Motor
m- B lu & lv_Slow . B Drive Statuc
- B lu & b M Program IMC controller ? *
- B Fle Q8 Fh M
- B lu & MotorSpeed Information
a-B luaTy DLL Version: ¥1.03.01 Releass Tims: 2019-11-26 Connection Part: COM18
- B Status 8 Spd /Trq Operation Options
- B Status & u
e | FluxAngle & SpdErr " Program Parameters & Program Firmware and Parameters ¢ Program Script ¢ Program Combined File
e-B &g File
- B Fh A & FlcB
- vd & vq Program Parameter File ‘E‘\Usels\gllar\g‘\ “Documents\BOARD Projects\EVAL-M1-30185nfine Browse...
- B 1dRef & 1d
Program Firrsare File: ‘E‘\Usels\gllar\g‘\ “Documents\BOARD Projects\EVAL-M1-3018Mnfine
Program Script File |
Program Combined Fils |
Start Cancel
< > < >
For Help, press F1 IMC301A COM18 DLL Using |Trig Idle ® Motorl Inactive System is On
. o o .
(13 ”»
Figure 10 Program firmware and parameters in “Program IMC Controller” pop-up window

To program only “Drive System Parameter” file into IMC301A-F064, click on “Tools” menu and select
“Programmer” in the pull-down list. The pop-up window “Program IMC controller” will show up as in Figure 11.
Click on the “Program Parameters” button (this is the default option), and then select the “Drive System
Parameter” file created using MCEWizard by clicking on “Browse...”. Finally, click on the “Start” button to
program the parameter file into the IMC301A-F064 IC.

File View Preferences Tools Window Help
= 88 ®
m [= =] = m [= || ®] =
¥l Ci\Users\gliang 1\Documents\BO/ ¥l Ci\Users\gliang I\Documents\BOZ
= Monitor Definitions =28 User Application Function Defi
B FlueAngle & MotorSpeed - .
. B MotorSpeed &Targetspee | Program IMC controller X
0 B & Fast Infaimation
Iu & Iv_SI
; g I: & F‘;;_h:'” DLL Wersion: ¥1.03.01 Release Time: 201911-28 Connection Port COM18
o B Fho 0 & Flm (Operation Optiores
0 B lu & MotorSpeed & Progiam Parsmnsters © Program Fimwate and Parametsrs © Progiam Seript  Program Combined File
o B v & Trg
- [ Status & Spd /Trg File
o B Status & Ilu
E B
- B Floctingie & Spkr Frogram Parameter File [:\Userstgiang!\Documents\BUARD Projects\EVAL M1 301ANNe  Brovvse
e Progrem Firmuare File |
o B Fix A &Pl B
o B vd &g -
aram Script File
o B 1dRef &1d ‘ ]
Program Combined File |
R
< > < >
For Help, press F1 IMC301A COMIB DLL Using [Trig Idle ® Motorl Inactive System is On

Figure1l “Program IMC Controller” pop-up window

After “Drive System Parameter” file has been programmed into IMC301A controller, and the motor drive system
is powered, the MCEDesigner can be used to start/stop the motor, display motor current traces, change the
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motor speed, modify drive parameters, and many other functions. Please refer to the MCEDesigner
documentation for more details.

Note: The on-board debugger section of EVAL-M1-301F is galvanically isolated from the controller
section and the attached power board. In order to program the parameters or firmware to the
IMC301A-F064 controller, the 3.3 V DC voltage needs to be supplied to the controller portion of the
EVAL-M1-301F. This voltage can either be supplied by the power board (MADK power boards are
designed to supply the 3.3 V to the control board through M1 or M3 connector) or by feeding the 3.3
V DC voltage to the control board through some of the available 3.3 V access/test points, if the
power board is not attached to the EVAL-M1-301F control board.

All the latest firmware files for different types of iIMOTION™ control ICs are available for download via Infineon
iMOTION™website (http://www.infineon.com/imotion-software).

5.3 Working with the MCU

The microcontroller in the IMC301A-F064 is based on an Arm® Cortex® MO core allowing the use of a wide range
of development tools and available software solutions.

Connection to the MCU is offered via the standard serial wire debug (SWD). The SWD interface is routed via the
galvanic isolation to the on-board interface. The debug interface is based on Segger® J-Link technology. The
respective DLL is installed on the PC during installation of the above-mentioned iMOTION tools, namely the
MCEDesigner. Alternatively, the installation of the respective driver can be updated from the Segger website.

Configuring, setting up and programming the embedded MCU is beyond the scope of this user guide. Please
refer to the Hardware Reference Manual of the IMC300 series and the CMSIS pack.
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6 Hardware description of EVAL-M1-301F

This chapter covers the hardware design of the EVAL-M1-301F in more detail. To enable users to make the EVAL-
M1-301F evaluation board a basis for a new development or modification of their own systems, all necessary
technical data such as schematics, layout and components are also included in this chapter.

6.1 Motor current feedback circuitry

6.1.1 Motor shunt configuration

Both single shunt and leg shunt topologies are supported by the EVAL-M1-301F control board. The user needs
to ensure that the shunt configuration matches with the power board hardware configuration. Please refer to
the power board user guide for details. The shunt configuration can be changed in the option page as shown in
Figure 12.

ﬁ MCEWizard 2.3.0.0 - C\Users\gliangT\Documents\EVAL-M1-301F-05-650.mc2 — b4

File  JumptoPage Help

Options Page -

Basic System Configuration Options
IMOTION™ Device Configuration Options Application Configuration Options

Product Family: MCipiT  System Info: val-M1-301F + Eval-M1-05-65D Evaluation Board|

Controller Device Package: LQFF-64 Firmware Version Select: V103200 v

Script Function Enable/Disable: Disable

Motor 1 PWM Frequency KHz

Application Control Interface: UART

Motor Fast Control Rate: | 1 |

Motor Control Options

Hardware Current Sensing Configuration Options
Motor Control Mode: Speed Control

Maotor Current Shunt Configuration: Leg Shunt -~ Rotor Angle Calculation Method: Flux PLL Angle ~

System Load Monitor
Hall Sensor Configuration: None Hall ~ ¥
Total CPU Load: _ 58% usage

Previous Mext

Figure 12 Shunt configuration

6.1.2 Motor external current feedback configuration and calculation

The shunt resistance Rs, value can be found in the schematics or user guide for the power board (for example,
the leg shunt resistors are 30 mQ for EVAL-M1-05-065D).
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The current input value is a product of the shunt resistance in milliohms and gain of external current sense
amplifier as shown in Figure 13.

Current Input
(mV/a)

Figure 13 Current shunt feedback and sample timing

Figure 14 depicts IU+ current feedback sensing circuity on EVAL-M1-301F evaluation board. Please note that the
default external amplification gain is less than 1 for current sense in this evaluation board.

+3.3V

R22 [ IMC301A
10k, 1%

Current shunt on
power board
. U

? [U
—_—CI15
221

~

Figure 14 The current feedback section on the EVAL-M1-301F evaluation board

Based on the principle of Kirchhoff's voltage law,

R23 R22

23
Vig = (V — I, *R # ———— + [ xRy = —————V + ——R, *
U (DD sh sh) R22 | R23 sh sh R22 R23 DD R22 | R23 sh sh
Curr ti put = 22 R, =—R
R22 R23 sh 6 sh

Rsn in EVAL-M1-05-065D is 250 mQ, based on this calculation, the current input for the MADK combination of
EVAL-M1-301F and EVAL-M1-05-065D is 208.3 mV/A. Please use the same procedure to calculate the current
input for other combinations of MADK boards and enter it into MCEWizard.
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£ MCEWizard 2.3.0.0 - C:\Users\gliang 1\Documents\EVAL-M1-301F-05-65D.mc2 - X

File JumptoPage Help

Question 83 : Motor 1 Current Feedback and Sample Timing - Motor 1 Current Input Scaling -

Motor 1 Current Feedback and Sample Timing
Question 83 - Motor 1 Current Input Scaling Expand Picture

This parameter is the gain of the external current single/leg

Dffsct & pain drcuit
shunt measurement circuit.

VCD

ik
This value is the product of the shunt resistance in millioshms | Zha
and the ac gain of the offset and gain circuit:

G extxR_s.

In the circuit example, the gain calculated from analysis with
Rs~(, is given by:
G_ext = R2 /(R1 + R2).

The input filter capacitor, C1, should be selected so that the
offset and gain circuit time constant is less than 400ns to
minimize the impact on current sampling.

Vip = G ‘:Vm'; G X RaX 1) \
won 4 5047 Vn= Vo + Gen & Re g
Vo | ss
VLD
High current applications may require an active offset and gain |
circuit to support low resistance shunts or to improve the
measurement signal to noise ratio.

Answer: ZDS.3| m\/A

Previous Next

Figure 15 Current feedback configuration in MCEWizard for EVAL-M1-301F and EVAL-M1-05-065D

6.1.3 Amplifier-gain configuration

For the current feedback, the iMOTION™ controller on this board has an internal amplifier, which has four
programmable gain settings: 1x, 3x, 6x and 12x.

The internal current-feedback amplifier gain can be configured in MCEWizard as shown in Figure 16.

3@, MCEWizard 2.3.0.0 - C\Users\gliang1\Documents\EVAL-M1-301F-05-63D.mc2 — *

File JumptoPage Help

Question 84 : Motor 1 Current Feedback and Sample Timing - Internal Current Feedback Amplifier Gain -

Motor 1 Current Feedback and Sample Timing

Question 84 - Internal Current Feedback Amplifier Gain Expand Picture

This parameter is the gain set for the programmable gain

fict & gain drcui
amplifier between the current sense pin and the ADC. oo *

This parameter is the gain set for the programmable gain e

amplifier between the current sense pin and the ADC. 1+
- . . &)

The available gain values are 1, 3, 6 and 12. The net gain '\-EH_

provided by the internal and external amplifiers determines the
current feedback range: I_range = (VDD/2)/(G_int X G_ext X
R_s)

The product of the gain and the voltage offset (V_off) should be

50% of VDD to ensure current sensing is centered around zero. _ i
wen o 23047 ¥n= Von+ Gexr & Ret g

An amplifier gain greater than 1 supports the use of low oo rall

resistance shunts to minimize the shunt power loss and size. It Vol I - i
also allows setting the overcurrent comparator level outside the i
current measurement range and maximize the use of the ADC [
measurement range.

Answer: 3 V|

Previous Next

Figure 16 Internal current-feedback amplifier-gain configuration
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6.2 EVAL-M1-301F analog inputs and their MCEWizard setup

Besides current-sensing inputs, IMC301A-F064 provides a number of analog inputs for different system
functions. Figure 17 depicts the analog inputs of the IMC301A-F064 except for the current-sensing inputs.

+3.3V :

' leo '
o DT ¥ 7,5 U S,
External Temerature Sensing input | VTH » NTC

——=Cl2

1103

) ) IMC301A
DC Bus Voltage Sensing input DCBSENSE ‘—e— DCBSENSE VDC

. §R21 J_.Cl4

{133k, 1% | *72

Figure 17 Analoginputs on the EVAL-M1-301F evaluation board

6.2.1 DC bus sensing configuration

The low-side resistor R4 for the DC bus sensing resistor divider on the controller board EVAL-M1-301F is 13.3 kQ,
and should be configured in MCEWizard as shown in Figure 18. For the high-side resistor value, please refer to
the user guide of the corresponding power board.

5_1 MCEWizard 2.3.0.0 - C\Users\gliang1\Documents\EVAL-M1-301F-03-650.mc2 - X

File JumptoPage Help

Question 51 : System DC Bus - DC Bus Sensing Low Resistor -

System DC Bus

Question 51 - DC Bus Sensing Low Resistor Expand Ficture

Typically, a resistor divider is used for the DC Bus voltage
sensing. Please specify the low resistor value, so that the
internal voltage scaling can be calculated based on the

attenuation of the resistor divider. DC bus

‘Warning: Incorrect resistor values may lead failure of the )
voltage protection functions and unsafe operation of the drive. y
o—+t

y

iy

| High
3 > Resistor

Lt}
el

To VDC

Low
Resistor

L}
l
L}

O

Answer: 13.3| KOhms

Previous Next

Figure 18 DC bus-sensing configuration in MCEWizard
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6.2.2 NTC shutdown value calculation and configuration

External NTC temperature shutdown values can be calculated as shown below and configured in MCEWizard as
shown in Figure 19. For the pull-up resistor on the evaluation power board and the NTC value, please refer to
the power board’s user guide. The value of the pull-up resistor on EVAL-M1-301F is 4.87 kQ (see Figure 17).

_ Rpull—up on Control board * Rpull—up on Power board
Rtotal pull-up — R

pull—up on Control board + Rpull—up on Power board

RNTC@setting temperature
VDD

Vshut down =
RNTC@setting temperature + Rtotal pull-up
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The typical value of Ryrc at 100°C is 2.9 kQ for the IPM IRSM505-065DA that is used in EVAL-M1-05-065D and no
pull-up resistor is connected. If the setting temperature is 100°C, the shutdown value should be 1.24 V.

2;.2 MCEWizard 2.3.0.0 - Ch\Users\gliang1\Docurnents\EVAL-M1-301F-03-650.mc2 - X

File JumptoPage Help

Question 72 : Motor 1 Fault Conditions - NTC Over-temperature Voltage Threshold -

Motor 1 Fault Conditions

Question 72 - NTC Over-temperature Voltage Threshold Expand Picture
This parameter sets the threshold level for Over Temperature
Shutdown. A wotorcurentlimt

OT Shutd
If the Over Temperature Shutdown is enabled, a fault is \—-—/ F uaeem
detected when the voltage at NTC input pin falls below the NTC E

Over-temperature Voltage Threshold Level.

Motor Temperature Limit
Tiow

W e

NTC Voltage Threshale ™ | __ ——

Answer: 124 V
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Figure 19 External temperature-sensing input configuration in MCEWizard
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6.3 Schematics overview

Figure 20 shows the schematics of EVAL-M1-301F evaluation board with IMC301A-F064 controller.
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Figure20 The schematics of the EVAL-M1-301F evaluation board

6.4 PCB layout overview

The layout of this board can be used for different voltages or power classes of the power board. The PCB has
two electrical layers with 35 pm copper by default, and its size is 65 mm x 45 mm. The PCB board thickness is
1.6 mm. Check Infineon’s website or get in contact with Infineon’s technical support team to obtain more
detailed information and the latest Gerber files.

Figure 21 illustrates the top assembly print and top paste layers of the evaluation board.
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Figure21 Top overlay print of the EVAL-M1-301F evaluation board

Figure 22 depicts the bottom assembly print of the evaluation board.
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Figure 22 Bottom overlay print of the EVAL-M1-301F evaluation board

The top layer routing of the PCB is provided in the following Figure 23.
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Figure 24 Bottom layer routing of the EVAL-M1-301F
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Bill of materials

Table 13 provides the complete bill of materials for the EVAL-M1-301F board.

Table 13 Bill of materials
No. | Qty. | Part description Designator | Part Number Manufacturer
10uF / 6.3V / 20% / X5R (EIA) |Cl1, C105,
1 3 / CAPC1608X90N 115 GRM188R60J106ME84
C2, Cl11,
C23, C101,
2 10 1000F / 16V / 5% / X7R (EIA) gigg, GRM188R71C104JA01
/ CAPC1608X90N ’
C104,
C108,
C110, C111
10nF / 16V / 5% / X7R (EIA) / |C3, C12,
3 3 CAPCL608X90N 16 GRM188R71C103JA01
1uF / 16V / 10% / X5R (EIA) / |C4, C17,
4 1 CAPC1608X90N C109, C113 GRMI8SR61CI05KALZ
C5, C6
4.7nF / 16V / 10% / X7R (EIA) T
5 6 C7, C8, GRM188R71C472KA01
/ CAPC1608X90N Cl4, €24
2.2nF / 50V / 5% / COG (EIA)
6 1 / NPO / CAPC1608X90N C10 GRM1885C1H222JA01
220pF / 50V / 2% / COG (EIA) |Cl15, C19,
! 3 / NPO / CAPC1608X90N C22 GRM1885CIH221GA01
15pF / 50V / 2% / COG (EIA) /
8 2 NPO / CAPC1608X90N C106, C107 |GRM1885C1H150GA01
4.7uF / 16V / 10% / X5R (EIA)
9 1 / CAPC1608X90N C112 GRM188R61C475KAAJ
10uF / 10V / 10% / X5R (EIA)
10 |1 / CAPC2013X95N Cl14 GRM219R61A106KE44
WR-PHD Pin Header, THT, pitch
11 |1 2. 54mm, Dual Row, Angled, J1 61302021021 Wurth Elektronik
20pin
WR-TBL Serie 2109 Horizontal
12 |1 Entry, Rising Cage Clamp, J2 691210910006 Wurth Elektronik
pitch 2.54mm, 6p
WR-PHD Pin Header, THT, pitch
13 |2 2. 54mm, Dual Row, Vertical, J3, J4 61300821121 Wurth Elektronik
8pin
WR-PHD Pin Header, THT, pitch
14 |2 1. 27mm, Dual Row, Vertical, J5, J6 62201021121 Wurth Elektronik
10pin
WR-PHD Pin Header, THT, pitch
15 |2 1.27mm, Dual Row, Vertical, J7, J8 62200421121 Wurth Elektronik
4pin
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No. | Qty. | Part description Designator | Part Number Manufacturer
WR-PHD Pin Header, THT, pitch
16 |1 2.54mm, Dual Row, Vertical, J9 61300421121 Wurth Elektronik
4pin
17 |1 60R / Ferrite Bead / SMD Chip |L101 BLM18PG600SN1
LED1,
18 |2 LED / 0603 LED102 LG L29K-G2]J1-24
LED2,
19 |2 LED / 0603 LED101 LS L29K-H1J2-1
20 |1 LED / 0603 LED103 LS L29K-H1J2-1
91 |1 12. 000MHz, 1000hm, 10uW, 8pF. 0101 NX3225GA-12. 000M—
Crystal STD—-CRG-2
R1, RZ2,
R3, R32,
22 |9 OR / OR / 0603 R33, R113, | CRCW06030000Z0
R114,
R115, R116
23 |3 1k / 1% / 0.10 / 0603 R4, R5, R6 | CRCWO6031K00FK
R7, R9,
24 |6 2k / 1% / 0.10 / 0603 R11, R13, CRCW06032K00FK
R16, R103
R8, RI10,
25 |4 OR / OR / 0603 R12, R14 CRCW06030000Z0
26 |2 9.1k / 1% / 0.10 / 0603 R15, R101 | CRCWO6039K10FK
27 |1 4.87k / 1% / 0.10 / 0603 R20 CRCW06034K87FK
28 |1 13.3k / 1% / 0.10 / 0603 R21 CRCW060313K3FK
29 |3 10k / 1% / 0.10 / 0603 ﬁgg’ R25, CRCW060310KO0FK
30 |3 2k / 1% / 0.10 / 0603 ﬁg?’ R26, CRCW06032K00FK
31 |1 3k / 1% / 0.10 / 0603 R102 CRCW06033K00FK
32 |2 33R / 1% / 0.10 / 0603 R104, R106 | CRCWO60333ROFK
33 |1 510R / 1% / 0.10 / 0603 R105 CRCW0603510RFK
34 |2 4.7k / 1% / 0.10 / 0603 R107, R111 | CRCWO6034K70FK
35 |2 10k / 1% / 0.10 / 0603 R108, R110 | CRCWO60310KOFK
36 |1 IMEG / 1% / 0.10 / 0603 R109 CRCW06031IMOOFK
37 |1 OR / OR / 0603 R112 CRCW06030000Z0
M3 X 6mm Pan Head, Cross Head gz;gz;’
38 |4 Metric Screw, 5.6mm X 2. 4mm ’ D00687
Head, Nylon 6,6 SCEEWS,
Screw4
Standoffl,
Hex-Standoff / Female - Standoff2,
39 14 Female M3 / 6 x 6 (DxH) Standoff3, 05.30. 315
Standoff4
None (onboard) / Board-to- TP1, TP2, ---
40 |9 Cable P9 20-2136
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No. | Qty. | Part description Designator | Part Number Manufacturer
A1 |1 High Performan?e motor U1 IMC301A-FO64 Infineon .
control IC series Technologies
42 |1 [3.63V - 3.13V / PG-VQPN-48-53 | U101 XMCAZ00Q4BRZOGABX | Infineon |
UMA1 Technologies
43 |1 |Linear / PG-S0T223-4 U102 IFX25001ME V33 | Ltineon
Technologies
a1 |1 Low Power Six—Channel Digital U103 ST8462BA-A-TS]
Isolator
45 |1 Bus Buffer/Line Driver; 3- U104 TALVC1GL26GH
State
46 |2 |1VS Diode / PG-TSSLP-2-1 V101, V102 |ESD237-Bl-Wogol | iineon
Technologies
47 |1 |Schottky Diode / SOD323 V103 BAS3010A-03W tnfineon
Technologies
Micro-USB 2.0 Standard, Type o
8 11 AB, Bottom Mount, Shell SMT K101 ZX62-AB-5PA(31)
WR-PHD Pin Header, THT, pitch
49 |1 2.54mm, Single Row, Vertical, | X102 61300511121 Wurth Elektronik
5pin
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8 Reference

[1]  IMC300 Series Datasheet

[2] IMC300 Hardware Reference Manual

[3] iMOTION™ MCE Software Reference Manual
[4] MCEWizard User Guide

[5] MCEDesigner User Guide

[6] Interfacing with IMOTION™ products, Application Note

Note: All listed reference materials are available for download on Infineon’s website
www.infineon.com/imotion. All User Guides of the iMOTION™ MADK power boards are available at
www.infineon.com/MADK

Notice:

Infineon’s product registration is now online. You can register your board online, and download additional
information.

There are three easy steps to register:

1. Go to www.Infineon.com/ login to myinfineon

2. Click on “Product Registration”

3. Choose your board, and enter board series number, then download the related information package
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